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1 Einleitung

1.1 Über dieses Dokument

1.1.1 Inhaltsbeschreibung
Dieses Dokument beschreibt Funktionen und Handhabung des Web
Builders zum Gestalten und Verwalten von HTML-Webseiten für den
servX WebServer in netIC IOT Kommunikationsmodulen. 
Hier finden Sie beispielhafte Schrittanleitungen für typische „Use Cases“,
wie z. B. der Anpassung der Standard-Layouts sowie die Personalisierung
der Webseiten-Inhalte. Außerdem finden Sie hier Informationen über
Zugriffsrechte und das Einbinden von netPROXY-Objektelementen in eine
Webseite.

Der Web Builder ist Bestandteil des Hilscher netX Studio Engineering
Tools. Beachten Sie, dass für das netX Studio Engineering Tool ein
eigenes Bedienerhandbuch namens netX Studio Engineering Tool -
Geräteentwicklung, DOC160103OIxxDE existiert, in dem Sie grundlegende
Informationen für Ihre Arbeit mit dem Tool finden, die in vorliegender
Application Note nicht enthalten sind.

1.1.2 Änderungsübersicht
Index Datum Änderungen
1 07.12.2016 Erstellt

Tabelle 1: Änderungsübersicht
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1.1.3 Konventionen in diesem Dokument
Hinweise, Handlungsanweisungen und Ergebnisse von Handlungen sind
wie folgt gekennzeichnet:

Hinweise

Wichtig:
<Wichtiger Hinweis>

Hinweis:
<Einfacher Hinweis>

<Hinweis, wo Sie weitere Informationen finden können>

Handlungsanweisungen

1. <Arbeitsschritt>
Ø <Handlungsanweisung>
Ø <Handlungsanweisung>

2. <Arbeitsschritt>
Ø <Handlungsanweisung>
Ø <Handlungsanweisung>

Handlungsergebnisse

 <Zwischenergebnis>

 <Endergebnis>
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1.2 Rechtliche Hinweise

1.2.1 Copyright
© Hilscher Gesellschaft für Systemautomation mbH

Alle Rechte vorbehalten.

Die Bilder, Fotografien und Texte der Begleitmaterialien
(Benutzerhandbuch, Begleittexte, Dokumentation etc.) sind durch
deutsches und internationales Urheberrecht sowie internationale Handels-
und Schutzbestimmungen geschützt. Sie sind ohne vorherige schriftliche
Genehmigung nicht berechtigt, diese vollständig oder teilweise durch
technische oder mechanische Verfahren zu vervielfältigen (Druck,
Fotokopie oder anderes Verfahren), unter Verwendung elektronischer
Systeme zu verarbeiten oder zu übertragen. Es ist Ihnen untersagt,
Veränderungen an Copyrightvermerken, Kennzeichen, Markenzeichen
oder Eigentumsangaben vorzunehmen. Darstellungen werden ohne
Rücksicht auf die Patentlage mitgeteilt. Die in diesem Dokument
enthaltenen Firmennamen und Produktbezeichnungen sind möglicherweise
Marken (Unternehmens- oder Warenmarken) der jeweiligen Inhaber und
können marken- oder patentrechtlich geschützt sein. Jede Form der
weiteren Nutzung bedarf der ausdrücklichen Genehmigung durch den
jeweiligen Inhaber der Rechte.

1.2.2 Wichtige Hinweise
Das Benutzerhandbuch, Begleittexte und die Dokumentation wurden mit
größter Sorgfalt erarbeitet. Fehler können jedoch nicht ausgeschlossen
werden. Eine Garantie, die juristische Verantwortung für fehlerhafte
Angaben oder irgendeine Haftung kann daher nicht übernommen werden.
Sie werden darauf hingewiesen, dass Beschreibungen in dem
Benutzerhandbuch, den Begleittexte und der Dokumentation weder eine
Garantie, noch eine Angabe über die nach dem Vertrag vorausgesetzte
Verwendung oder eine zugesicherte Eigenschaft darstellen. Es kann nicht
ausgeschlossen werden, dass das Benutzerhandbuch, die Begleittexte und
die Dokumentation nicht vollständig mit den beschriebenen Eigenschaften,
Normen oder sonstigen Daten der gelieferten Produkte übereinstimmen.
Eine Gewähr oder Garantie bezüglich der Richtigkeit oder Genauigkeit der
Informationen wird nicht übernommen.

Wir behalten uns das Recht vor, unsere Produkte und deren Spezifikation,
sowie zugehörige Benutzerhandbücher, Begleittexte und Dokumentationen
jederzeit und ohne Vorankündigung zu ändern, ohne zur Anzeige der
Änderung verpflichtet zu sein. Änderungen werden in zukünftigen Manuals
berücksichtigt und stellen keine Verpflichtung dar; insbesondere besteht
kein Anspruch auf Überarbeitung gelieferter Dokumente. Es gilt jeweils das
Manual, das mit dem Produkt ausgeliefert wird.

Die Hilscher Gesellschaft für Systemautomation mbH haftet unter keinen
Umständen für direkte, indirekte, Neben- oder Folgeschäden oder
Einkommensverluste, die aus der Verwendung der hier enthaltenen
Informationen entstehen.

netX Studio Engineering Tool | Web Builder
DOC160207AN01DE | Revision 1 | Deutsch | 2016-12 | Freigegeben | Öffentlich

© Hilscher 2016



Einleitung 6/48

1.2.3 Haftungsausschluss
Die Software wurde von der Hilscher Gesellschaft für Systemautomation
mbH sorgfältig erstellt und getestet und wird im reinen Ist-Zustand zur
Verfügung gestellt. Es kann keine Gewährleistung für die Leistungsfähigkeit
und Fehlerfreiheit der Software für alle Anwendungsbedingungen und -fälle
und die erzielten Arbeitsergebnisse bei Verwendung der Software durch
den Benutzer übernommen werden. Die Haftung für etwaige Schäden, die
durch die Verwendung der Hard- und Software oder der zugehörigen
Dokumente entstanden sein könnten, beschränkt sich auf den Fall des
Vorsatzes oder der grob fahrlässigen Verletzung wesentlicher
Vertragspflichten. Der Schadensersatzanspruch für die Verletzung
wesentlicher Vertragspflichten ist jedoch auf den vertragstypischen
vorhersehbaren Schaden begrenzt.

Es ist strikt untersagt, die Software in folgenden Bereichen zu verwenden:
· für militärische Zwecke oder in Waffensystemen;
· zum Entwurf, zur Konstruktion, Wartung oder zum Betrieb von

Nuklearanlagen;
· in Flugsicherungssystemen, Flugverkehrs- oder

Flugkommunikationssystemen;
· in Lebenserhaltungssystemen;
· in Systemen, in denen Fehlfunktionen der Software körperliche

Schäden oder Verletzungen mit Todesfolge nach sich ziehen können.

Sie werden darauf hingewiesen, dass die Software nicht für die
Verwendung in Gefahrumgebungen erstellt worden ist, die ausfallsichere
Kontrollmechanismen erfordern. Die Benutzung der Software in einer
solchen Umgebung geschieht auf eigene Gefahr; jede Haftung für Schäden
oder Verluste aufgrund unerlaubter Benutzung ist ausgeschlossen.

1.2.4 Gewährleistung
Obwohl die Hard- und Software mit aller Sorgfalt entwickelt und intensiv
getestet wurde, übernimmt die Hilscher Gesellschaft für Systemautomation
mbH keine Garantie für die Eignung für irgendeinen Zweck, der nicht
schriftlich bestätigt wurde. Es kann nicht gewährleistet werden, dass die
Hard- und Software Ihren Anforderungen entspricht, die Verwendung der
Software unterbrechungsfrei und die Software fehlerfrei ist. Eine Garantie
auf Nichtübertretung, Nichtverletzung von Patenten, Eigentumsrecht oder
Freiheit von Einwirkungen Dritter wird nicht gewährt. Weitere Garantien
oder Zusicherungen hinsichtlich Marktgängigkeit, Rechtsmängelfreiheit,
Integrierung oder Brauchbarkeit für bestimmte Zwecke werden nicht
gewährt, es sei denn, diese sind nach geltendem Recht vorgeschrieben
und können nicht eingeschränkt werden. Gewährleistungsansprüche
beschränken sich auf das Recht, Nachbesserung zu verlangen.
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1.2.5 Exportbestimmungen
Das gelieferte Produkt (einschließlich der technischen Daten) unterliegt den
gesetzlichen Export- bzw. Importgesetzen sowie damit verbundenen
Vorschriften verschiedener Länder, insbesondere denen von Deutschland
und den USA. Die Software darf nicht in Länder exportiert werden, in denen
dies durch das US-amerikanische Exportkontrollgesetz und dessen
ergänzender Bestimmungen verboten ist. Sie verpflichten sich, die
Vorschriften strikt zu befolgen und in eigener Verantwortung einzuhalten.
Sie werden darauf hingewiesen, dass Sie zum Export, zur Wiederausfuhr
oder zum Import des Produktes unter Umständen staatlicher
Genehmigungen bedürfen.
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2 Kurzbeschreibung Web Builder für servX WebServer
Der in das netX Studio Engineering Tool integrierte Web Builder dient
dem Gestalten und Verwalten von Web-Content (HTML-Seiten, CSS, Java
Script und Bild-Dateien) für den servX WebServer. Der servX WebServer
ist Bestandteil der Firmware für Hilscher-Geräte (z. B. netIC IOT DIL-32
Kommunikationsmodul) und ermöglicht den Zugriff auf das
Automatisierungsgerät im Feld über dessen Ethernet-Schnittstelle mittels
Standard-Webbrowser und HTTP. 
Geräte, die Firmware mit integriertem servX WebServer und netPROXY-
Server enthalten und mit dem netX Studio Engineering Tool konfiguriert
wurden, erlauben das Lesen und Schreiben von Geräte-Parametern und
IO-Daten über HTTP.

Die Standard-Funktionen des WebServers umfassen:
· Anzeige von allgemeinen Geräte-Informationen wie z. B. Version,

Seriennummer, MAC-Adresse, Wartungshinweise (Home)

· Konfiguration von integriertem MQTT-Client (Configuration > MQTT
Client) und OPC-UA-Server (Configuration > OPC UA Server)
[falls aktiviert]

· Diagnose von IP-Einstellung (Diagnosis > IP-Settings),
Netzwerkstatus (Diagnosis > Communication) und Ethernet-
Verbindung (Diagnosis > Ethernet)

· Geräteparameter/netPROXY-Objekte lesen und schreiben (Diagnosis
> Object Data)

· Download der in dem Gerät gespeicherten Gerätebeschreibungsdatei
(Download)

· Benutzerverwaltung (Administration > User/Password
Management)

· Geräte-Reset (Administration > Reset Device)
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Funktionen und Design der auf dem WebServer bereitgestellten Web-
Seiten können mit Hilfe des Web Builders nach eigenen Vorstellungen
gestaltet und verwaltet werden. Der Web Builder fungiert dabei innerhalb
von netX Studio als eine Art „Content-Management-System“ für die Inhalte
des WebServers. Einzelnen Produkt- bzw. Gerätevarianten können mit
Hilfe sogenannter „Produkt-Makros“ individuell gestaltete Web-Seiten und
Grafiken (z. B. unterschiedliche Gerätenamen und Produktfotos für
unterschiedliche Zielgeräte) zugeordnet werden, die nach dem Build-
Prozess zusammen mit den übrigen Daten, die in netX Studio erstellt und/
oder verwaltet werden (Firmware, Konfigurationsdaten, Geräte- und
Hersteller-Parameter), in die Geräte geladen werden können. 

Abbildung 1: Webseiten für servX WebServer mit Web Builder erstellen
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3 Beispiele für das Einbinden eigener Inhalte

3.1 Übersicht
In diesem Abschnitt finden Sie Schrittanleitungen für einige typische
Anpassungen, die Sie als Nutzer an den Inhalten des Web Builders
vornehmen können. 
Dies sind:
· Austausch des Firmenlogos und Hinterlegen eines Hyperlinks
· Ändern des Begrüßungstextes auf der Startseite
· Ändern des Hintergrund-Designs der Navigationsleiste, Vergrößern der

Standardschrift und Ändern der Schriftfarbe für Überschriften im CSS-
Stylesheet

Startseite vor der Anpassung:

Abbildung 2: Startseite ohne Anpassung
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Startseite nach der Anpassung:

Abbildung 3: Startseite nach Anpassung

Hinweis:
Beachten Sie, dass die in diesem Kapitel dargestellten
Vorgehensweisen beispielhaften Charakter haben und – abhängig
von Ihren Kenntnissen in Webdesign – auch andere
Vorgehensweisen möglich sind.
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3.2 Firmenlogo tauschen und Hyperlink zur eigenen
Firmenwebseite einfügen

In den vom Web Builder erzeugten Webseiten wird standardmäßig das
Hilscher-Logo angezeigt. Das Logo ist in der HTML-Datei home.htm
referenziert, welche diejenigen Standard-Elemente enthält bzw. verlinkt, die
auf jeder HTML-Seite angezeigt werden sollen, wie z. B. das
Navigationsmenü, Texte in der Kopf- und Fußzeile sowie besagtes
Firmenlogo. 
Dieser Abschnitt zeigt, wie Sie das Hilscher-Logo durch Ihr eigenes
Firmenlogo ersetzen und mit einem Hyperlink verknüpfen, sodass man
durch Anklicken des Logos auf eine von Ihnen festgelegte Webseite im
World Wide Web gelangt – in diesem Beispiel auf eine fiktive Internet-
Homepage.

1. Projekt öffnen.
Ø Starten Sie das netX Studio Engineering Tool und öffnen Sie das

Projekt, dessen Webseiten Sie bearbeiten möchten (in diesem Beispiel
das Projekt Series B).

Ø Scrollen Sie im Project Explorer nach unten zu dem Objekt Web
Builder.

Abbildung 4: Web Builder in geöffneten Projekt
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2. Eigene Logo-Bilddatei importieren.
Ø Markieren Sie im Project Explorer den Ordner Web Builder > Content

> Images.
Ø Wählen Sie anschließend im Kontextmenü Add Files.

Abbildung 5: Datei hinzufügen

Ê Der Windows-Dateiauswahldialog öffnet sich.
Ø Wählen Sie in Ihrem Dateisystem die Bilddatei, die Ihr Logo enthält, und

klicken Sie anschließend Öffnen.
Ê Die Bilddatei wird importiert und dem Ordner Images hinzugefügt. In

diesem Beispiel ist dies die Datei Logo_1.png.

Abbildung 6: Neue Logo-Bilddatei im Project Explorer
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3. HTML-Datei öffnen.
Ø Doppelklicken Sie im Ordner Web Builder > Content die Datei

home.htm.
Ê Die Datei öffnet sich im Editor. Wenn für die netX Studio GUI das

Default Layout eingestellt ist (Hauptmenü Window > Default Layout)
sehen Sie in der oberen Hälfte eine Layout-Vorschau (Design Page), in
der unteren Hälfte können Sie den Quellcode (Source Page) editieren:

Abbildung 7: Homepage in Editor
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4. Hyperlink auf eigene Firmen-Homepage ergänzen.
Ø Scrollen Sie in der Source Page (untere Hälfte des Editors) zu dem

Element, welches das Logo und den Hyperlink referenziert. Um sich
eine Suche im Quellcode zu ersparen, können Sie alternativ in der
Design Page in der oberen Hälfte des Editors das gesuchte Element (in
diesem Beispiel das Hilscher-Logo) anklicken. Die Source Page in der
unteren Hälfte des Editors springt dann automatisch in den
entsprechenden Abschnitt und markiert das gesuchte Quellcode-
Element:

Abbildung 8: Autofokus auf Quellcode-Element für Logo

Ø Ergänzen Sie im Hyperlink <a id=“LogoLink“ href=““> hinter
dem Attribut href= ““ innerhalb der leeren Anführungszeichen Ihre
Webadresse, z. B. “http://www.mustermann-automation.com“

Abbildung 9: Eigene Webadresse eingeben

5. Eigene Logo-Bilddatei referenzieren.
Ø Ersetzen Sie im Tag <img src=“Images/h_logo.png“

alt=“Logo Hilscher“ title=“Hilscher GmbH“> </a> im Pfad
für die Bild-Quelle img src=“Images/h_logo.png“ den Namen der
bisher verwendeten Bilddatei h_logo.png durch den Namen der
Bilddatei, die Sie in Schritt 1 importiert haben, z. B. Logo_1.

Ø Ersetzen Sie im Alternativ-Text alt=“Logo Hilscher“ den Text
“Logo Hilscher“ durch den Text, der alternativ für den Fall
angezeigt werden soll, dass die Bilddatei im verwendeten Browser nicht
angezeigt werden kann (z. B. “Logo Mustermann Automation“).
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Ø Ersetzen Sie im Titel-Attribut title=“Hilscher GmbH“ den Eintrag
“Hilscher GmbH“ durch den Text, der als Tooltip angezeigt werden
soll, wenn der Betrachter der Webseite mit der Maus über das Bild bzw.
das Logo fährt (z. B. “Go to Mustermann website“).

Ê Das Element mit dem Hyperlink und dem Logo sollte nun
folgendermaßen aussehen (in der Layout-Vorschau im oberen Bereich
wird nun bereits auch schon das neue Logo angezeigt):

Abbildung 10: Geänderte Bild-Attribute

Ø Wählen Sie im Menü File > Save oder drücken Sie Strg + S auf Ihrer
Tastatur, um die Änderungen in der Datei home.htm zu speichern.

ð Sie haben das Hilscher-Logo durch Ihr eigenes Logo ersetzt und auf
dem Logo einen Hyperlink auf Ihre eigene Website hinterlegt.
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3.3 Seiten-Layout im Cascading Style Sheet (CSS) ändern
Layout und Design der vom Web Builder erzeugten Webseiten werden
standardmäßig im Cascading Style Sheet namens style.css definiert.
Dort sind u. a. die Seitenaufteilung, die Schrift-Gestaltung (Font,
Schriftgröße, Formatierung, Schriftfarbe etc.) sowie die Gestaltung der
Kopf- und Fußzeile festgelegt.
Dieser Abschnitt zeigt, wie Sie das Erscheinungsbild der Kopfzeile
verändern können, indem Sie die Hintergrund-Grafik entfernen, die
Kopfzeile grau einfärben sowie die Menüleiste nach oben verschieben.
Außerdem wird gezeigt, wie Sie die Standard-Schrift von 10 Punkt auf 12
Punkt vergrößern und die Überschriften der ersten Ordnung (H1) von rot
auf blau umfärben können.

1. CSS-Datei öffnen.
Ø Doppelklicken Sie im Ordner Web Builder > Content > css die Datei

style.css.
Ê Die Datei öffnet sich im Editor:

Abbildung 11: CSS-Datei

netX Studio Engineering Tool | Web Builder
DOC160207AN01DE | Revision 1 | Deutsch | 2016-12 | Freigegeben | Öffentlich

© Hilscher 2016



Beispiele für das Einbinden eigener Inhalte 18/48

2. Hintergrundbild der Kopfleiste gegen graue Fläche tauschen.
Ø Ersetzen Sie im Abschnitt

body > header {
background-image: url(“../Images/topbarr.png”);
background-position: center 2em;
background-repeat: no-repeat;
}
die Referenz auf das Hintergrundbild
background-image: url(“../Images/topbarr.png”);
durch eine Farbdefinition für eine graue Hintergrundfläche, z. B. 
background-color: #E6E6E6;

Abbildung 12: Hintergrundbild durch Farbdefinition ersetzen

3. Standardschrift vergrößern.
Ø Scrollen Sie im Style-Sheet zum Bereich /*** CONTENT ***/ und

dort zu der Deklaration der Standardschriftgröße 
body, p, li, td, div { 
font-size: 10pt;
}

Abbildung 13: Deklaration der Größe der Standardschrift

Ø Ändern Sie den Wert font-size von 10pt auf 12pt.
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4. Farbe von Überschriften der ersten Ordnung (H1) ändern.
Ø Ändern Sie im Absatz darunter in der Deklaration der Überschrift H1 

h1 {
font-size: 150%;
color: #e30613;
}
die Farbe color: #e30613 auf einen anderen Farbwert, z. B. auf
#0000FF für blau.

Abbildung 14: H1-Farbe ändern

5. Menüleiste nach oben versetzen.
Ø Scrollen Sie im Style-Sheet nach unten zu dem Abschnitt, der die

Position der Navigationsleiste deklariert
#main_nav {
position: absolute;
bottom: 40px;
left: 0; 
}

Abbildung 15: Position der Navigationsleiste ändern
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Ø Erhöhen Sie den Wert bottom: 40px; auf z. B. 120px;
(Dies bewirkt, dass das Navigationsmenü vom unteren Rand der
Kopfzeile anstelle von 40 Pixel nun um 120 Pixel nach oben abgesetzt
ist. Dies hat eine Verschiebung des Navigationsmenüs von 80 Pixel
nach oben zur Folge.)

Ø Wählen Sie im Menü File > Save oder drücken Sie Strg + S auf Ihrer
Tastatur, um die Änderungen in der Datei style.css zu speichern.
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3.4 Text in HTML-Seiten ändern
Dieser Abschnitt zeigt, wie Sie den Begrüßungstext auf der Seite info.htm
verändern können. Die Seite info.htm ist als Inline-Frame in die Seite
home.htm eingebunden, welche wiederum nach Aufruf der Seite
index.htm zuerst angezeigt wird.

1. HTML-Seite öffnen.
Ø Doppelklicken Sie im Ordner Web Builder > Content > sites die Datei

info.htm.
Ê Die Datei öffnet sich im Editor:

Abbildung 16: Geöffnete info.htm-Datei

netX Studio Engineering Tool | Web Builder
DOC160207AN01DE | Revision 1 | Deutsch | 2016-12 | Freigegeben | Öffentlich

© Hilscher 2016



Beispiele für das Einbinden eigener Inhalte 22/48

2. Neuen Text eingeben.
Ø Scrollen Sie in der Source Page (untere Hälfte des Editors) zum ersten

Textabsatz, den Sie ändern möchten, z. B. die Überschrift netX Device
(alternativ können Sie oben den zu ändernden Text anklicken, um unten
zum entsprechenden Quellcode zu gelangen):

Abbildung 17: Überschriftentext ändern

Ø Ersetzen Sie im Tag <p><h1>netX Device</h1></p> </br> den
Begriff netX Device durch einen individuellen Gerätenamen, z. B.
B100-EIS. 
Ändern Sie weitere Textelemente nach Bedarf.

Abbildung 18: Begrüßungstext ändern

Ø Wählen Sie im Menü File > Save oder drücken Sie Strg + S auf Ihrer
Tastatur, um die Änderungen in der Datei info.htm zu speichern.

ð Sie haben Layout und Inhalte der mitgelieferten Default-Webseiten des
Web Builders geändert.
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4 Webseiten für Produktvarianten mittels Product Macros
individuell gestalten

4.1 Übersicht
Während des Build-Prozesses werden die im Web Builder gestalteten und
verwalteten Inhalte (d. h. die HTML-Seiten, Grafiken, Java-Skripte und
Style-Sheets) komprimiert und in eine Archiv-Datei im TAR-Format namens
content.tar gepackt.

Für jede Produktvariante, die in Ihrem Projekt enthalten ist, wird dabei eine
eigene content.tar-Datei generiert und jeweils im Verzeichnis Product
Build > Products > [Produktname] > Web Builder abgelegt.

Abbildung 19: Content.tar-Dateien in Project Explorer

Die content.tar-Datei kann anschließend zusammen mit den anderen
Produkt-Konfigurationsdateien oder auch separat über USB von netX
Studio in das Zielgerät geladen werden. Eine Anleitung hierzu finden Sie im
Bedienerhandbuch netX Studio Engineering Tool, DOC160103OIXXDE im
Abschnitt Produktdateien herunterladen.
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Solange Sie keine Produkt-Makros definiert haben, unterscheidet sich der
Inhalt der content.tar-Dateien für die einzelnen Produktvarianten nicht; d. h.
in jeder content.tar-Datei sind dieselben HTML-Seiten, Grafiken,
Stylesheets etc. enthalten.

Wenn Sie einzelnen Produktvarianten unterschiedliche Inhalte (d. h.
individualisierte Texte und Bilder innerhalb der Webseiten) zuweisen
möchten, müssen Sie die sogenannten Product Macros des netX Studio
Engineering Tools einsetzen.

Das Element Product Macros wird automatisch jedem Produkt bzw. jeder
Produktvariante hinzugefügt, die Sie im Ordner Product Details neu
anlegen. Das Element enthält zunächst eine leere Liste, in die Sie die
produktspezifischen Variablen eintragen können, die für die betreffende
Produktvariante beim Build-Prozess verwendet werden sollen.

Abbildung 20: Produkt-Makro

In die Spalte Macros werden die Variablen eingetragen, in der Spalte
Expands to... die für die Produktvariante geltenden Werte.

Eine Variable muss immer mit dem Prozentzeichen % eingeleitet und
abgeschlossen werden, z. B. %DEVICE_NAME%.

Für den zugehörigen Wert in der Spalte Expands to... gelten keine
besonderen Regeln; hier können Sie beliebige Zeichen-Strings wie z. B.
den Gerätenamen B100-EIS Adapter Module oder einen Link auf eine
zu verwendende Bilddatei oder ein Stylesheet eintragen.
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Die Variablen können Sie im Quellcode einer beliebigen HTML-Seite des
Web Builders platzieren, z. B. in der Startseite home.htm im Header die
%STYLESHEET%-Variable für das Layout, im Begrüßungstext die Variable
%DEVICE_NAME% für den Gerätenamen und darunter die Variable 
%IMAGE% für ein individuelles Gerätebild. 
Während des Build-Prozesses werden diese Variablen durch die in den
Produkt-Makros definierten produktspezifischen Zeichen-Strings bzw.
Dateipfade ersetzt, und so für jede Produktvariante eine individuelle
Startseite mit z. B. eigenem Farb-Layout (%STYLESHEET%), Gerätenamen
(%DEVICE_NAME%) und Produktfoto (%IMAGE%) erzeugt (siehe
Flussdiagramm auf nachfolgender Seite).
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Abbildung 21: Product Macros und Variablen im Build-Prozess
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4.2 Anwendungsbeispiel für Product Macros

Voraussetzungen
· Sie haben für jede Produktvariante ein eigenes Cascading Style Sheet

erstellt (z. B. ein Stylesheet style_blue.css, style_green.css,
style_yellow.css und style_grey.css) und in den Ordner Web Builder
> Content > css importiert.

· Sie haben für jede Produktvariante eine eigene Bilddatei (z. B. B100-
EIS.jpg, B100_PNS.jpg, B150-EIS.jpg und B150-PNS.jpg) in den
Ordner Web Builder > Content > Images importiert.

Hinweis:
Sie können Dateien in den Web Builder importieren, indem Sie den
Zielordner im Project Explorer markieren und anschließend im
Kontextmenü Add Files wählen.

Schrittanleitung
1. Variable für CSS-Stylesheet im HTML-Code der home.htm platzieren.

Ø Doppelklicken Sie im Ordner Web Builder > Content die Datei
home.htm.

Ê Die Datei öffnet sich im Editor:

Abbildung 22: Geöffnete home.htm
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Ø Ersetzen Sie in den „Kopfdaten“ (i. e. im <head>-Element) den Link auf
das CSS-Stylesheet <link rel="stylesheet" type="text/
css" href="css/style.css"> durch die Variable %STYLESHEET%.

Abbildung 23: Variable für CSS-Stylesheet einfügen

Ø Drücken Sie Strg + S auf Ihrer Tastatur, um die Änderungen in der
Datei home.htm zu speichern.

2. Variable für Gerätenamen im HTML-Code der info.htm platzieren.
Ø Doppelklicken Sie im Ordner Web Builder > Content > sites die Datei

info.htm.
Ê Die Datei öffnet sich im Editor:

Abbildung 24: Info page
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Ø Scrollen Sie in der Source Page (untere Hälfte des Editors) zu den
Textabsätzen, die den Gerätenamen enthalten.

Abbildung 25: Gerätenamen in Quelltext

Ø Ersetzen Sie den Gerätenamen (in diesem Beispiel B100-EIS in der
Überschrift <h1> und B100-EIS module im Fließtext) durch die
Variable %DEVICE_NAME%.

Abbildung 26: Eingefügte Variable für Gerätenamen
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3. Variable für Produktbild platzieren.
Ø Navigieren Sie zu der Zeile, die den Link auf das Produktbild enthält:

Abbildung 27: Link auf Produktbild

Ø Ersetzen Sie den Link auf das Produktbild <img src="../Images/
NIC 52-RE.png" alt="Device"> durch die Variable %IMAGE%.

Abbildung 28: Eingefügte Variable für Produktbild

Ø Drücken Sie Strg + S auf Ihrer Tastatur, um die Änderungen in der
Datei info.htm zu speichern.
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4. Produkt-Makro für erste Produktvariante öffnen.
Ø Doppelklicken Sie im Ordner Product Details > [Produktname] das

Element Product Macros.
Ê Eine leere Makro-Liste für die Produktvariante öffnet sich im Editor.

5. Variablen für erste Produktvariante definieren.
Ø Klicken Sie die Schaltfläche Add, um ein neues Makro zu definieren.

Abbildung 29: Makro öffnen

Ê Der Editor fügt in der Spalte Macros eine Dummy-Variable namens
%Macro_1% ein und rechts in der Spalte Expands to... den Platzhalter
<type text here>.

Ø Ersetzen Sie die Dummy-Variable %Macro_1% im Feld Macros durch
die Variable %STYLESHEET%. Tragen Sie im Feld Expands to... den
Link auf das CSS-Stylesheet ein, das Sie für diese Produktvariante
verwenden möchten, z. B. <link rel="stylesheet"
type="text/css" href="css/style_blue.css">.

Ø Klicken Sie erneut die Schaltfläche Add und tragen Sie die Variable für
den Gerätenamen %DEVICE_NAME% ein. Tragen Sie im Feld Expands
to... den Namen ein, den Sie für diese Produktvariante verwenden
möchten, z. B. B100-EIS Adapter Module.
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Ø Tragen Sie zuletzt noch die Variable für das Produktbild %IMAGE% ein,
sowie den Pfad auf die Bilddatei, die Sie für diese Produktvariante
verwenden möchten, z. B. <img src="../Images/B100-
EIS.jpg">.

Abbildung 30: Variablen für Produkt B100-EIS

Ê Sie haben die Makros bzw. die Variablen für Ihre erste Produktvariante
definiert.
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6. Variablen für zweite Produktvariante definieren.
Ø Öffnen Sie die Product Macros für Ihre nächste Produktvariante,

klicken Sie die Schaltfläche Add und tragen Sie links in der Spalte
Macros die Variablen %STYLESHEET%, %DEVICE_NAME% und %IMAGE%
ein. Tragen Sie rechts in der Spalte Expands to.. jeweils den Pfad auf
das Stylesheet, den Gerätenamen sowie den Pfad auf die Bilddatei ein,
den Sie für diese Produktvariante verwenden wollen:

Abbildung 31: Variablen für Produkt B100-PNS

Ê Sie haben die Makros bzw. die Variablen für Ihre zweite
Produktvariante definiert.

7. Variablen für restliche Produktvarianten definieren.
Ø Wiederholen Sie die oben beschriebene Vorgehensweise für die

Produkt-Makros aller übrigen Produkte in Ihrem Projekt.

Wichtig:
Beachten Sie, dass Sie für jede Variable, die Sie in den gemeinsam
genutzten Ressourcen des Projektes verwenden, auch für jede
Produktvariante einen Wert in den Produkt-Makros definieren
müssen. Ansonsten wird die Variable nicht aufgelöst und auf der
Webseite der betreffenden Produktvariante erscheint die Variable
aufgrund des fehlenden Wertes in ihrem ursprünglichen
Zeichenstring, (z. B. %DEVICE_NAME% im Begrüßungstext der
home.htm page). Außerdem würden Stylesheets und Bilder, die als
Variablen eingebunden wurden, komplett fehlen, da sie nicht
zugewiesen werden konnten.

ð Sie haben Produkt-Makros definiert und eingebunden, und können nun
den Build-Prozess starten.
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5 Web-Content vor Download lokal im Browser prüfen
Für den Fall, dass Sie nach dem Build-Prozess die Webseiten vor dem
Download in das Zielgerät mit Ihrem Standard-Browser lokal auf Ihrem
Entwicklungs-PC anschauen und überprüfen möchten, bietet Ihnen netX
Studio eine schnelle Zugriffsmöglichkeit auf die content.tar-Datei per
Windows Explorer. Im Windows Explorer können Sie die TAR-Datei lokal in
ein beliebiges Verzeichnis auf Ihrem PC kopieren, entpacken und
anschließend die Webseiten lokal im Browser öffnen. 
Falls Ihr Projekt unterschiedliche Produkte bzw. Produktvarianten enthält
und Sie Produkt-Makros zum Personalisieren der Webseiten verwendet
haben, können Sie diesen Vorgang nacheinander für alle erzeugten
Content-Archivdateien durchführen und somit überprüfen, ob die Variablen
korrekt umgesetzt wurden.

Gehen Sie hierzu folgendermaßen vor:

1. Content-Archivdatei lokal kopieren.
Ø Öffnen Sie im Project Explorer nach dem Build-Prozess den Ordner

Product Build > Products > [Produktname] > Web Builder.
Ø Markieren Sie den Ordner Web Builder und wählen Sie anschließend

im Kontextmenü Show in Windows Explorer

Abbildung 32: Ordner in Windows Explorer öffnen
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Ê Der Windows Explorer öffnet sich und zeigt das entsprechende
Verzeichnis auf Ihrem File System:

Abbildung 33: Product Build-Verzeichnis im Windows Explorer

Ø Öffnen Sie den Ordner Web Builder und kopieren Sie die darin
enthaltene content.tar-Datei in ein beliebiges Verzeichnis, z. B. auf
Ihren Desktop.

2. Archivdatei entpacken.
Ø Entpacken Sie die content.tar-Datei mit einem Packprogramm,

welches das TAR-Format unterstützt, z. B. mit dem Programm 7-Zip.
Ê Die entpackte content.tar-Datei enthält die gleichen Elemente wie der

Ordner Content aus dem Web Builder, jedoch nun durch den Build-
Prozess weiterverarbeitet. D. h. falls Sie Produkt-Makros verwendet
haben, wurden die Variablen innerhalb der HTML-Seiten durch die für
die Produktvariante definierten Werte ersetzt.

Abbildung 34: Entpackter Content-Ordner
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3. Webseiten anzeigen.
Ø Führen Sie einen Doppelklick auf der Datei index.htm oder home.htm

aus.
ð Die Startseite Ihres Web-Content wird in Ihrem Standard-Browser

angezeigt:

Abbildung 35: Startseite von Produkt B100-EIS lokal angezeigt

Hinweis:
Beachten Sie, dass bestimmte Inhalte nicht angezeigt werden
können (siehe den Hinweis „Object is not available“ in obiger
Abbildung) , wenn Sie die Webseiten lokal öffnen. Dies sind
diejenigen Datenobjekte, die der servX WebServer per Java-Script
aus dem netPROXY-Server des Gerätes auslesen und bereitstellen
würde, wenn Sie die Webseiten tatsächlich in das Gerät geladen
hätten, anstatt sie lokal auf dem Rechner zu öffnen, wo diese
Datenobjekte nicht verfügbar sind.

Ø Wiederholen Sie den Vorgang ggf. für die content.tar-Dateien der
übrigen Produkte/Produktvarianten.
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6 Festlegung der Zugriffsrechte auf Webseiten
Übersicht

Die Zugriffsrechte eines Nutzers auf einzelne Webseiten (und somit auf
bestimmte Funktionen des WebServers) werden über die Zugehörigkeit
des Nutzers zu einer oder mehreren Benutzergruppen (auch „Rollen“
genannt) gesteuert. Für den WebServer und den FTP-Server existieren
folgende Benutzergruppen/Rollen:
· Administrator
· Supervisor
· User

Nutzer und Benutzergruppen

Die Zugehörigkeit eines Nutzers zu einer oder mehreren Benutzergruppen
können Sie im netX Studio Engineering Tool unter User Management im
Element User Accounts definieren. 
Eine Anleitung hierzu finden Sie im Bedienerhandbuch netX Studio
Engineering Tool – Geräteentwicklung, DOC160103OIXXDE im Abschnitt
Benutzerverwaltung konfigurieren.

Hinweis:
Standardmäßig ist ein Master-Nutzer mit allen Zugriffsrechten unter
dem Benutzernamen („User Name“) admin und dem Passwort
admin vordefiniert. Es wird dringend empfohlen, das vordefinierte
Passwort für diesen Master-Nutzer zu ändern (der Master-Nutzer
selber kann nicht gelöscht oder bearbeitet werden).

Beachten Sie, dass auch nach dem Konfigurieren des Projekts mittels
netXStudio und dem Herunterladen in das Zielgerät noch eine
„nachträgliche“ Benutzerverwaltung (d. h. das Anlegen neuer Benutzer,
Zuweisen von Benutzergruppen/Rollen und Passwort-Verwaltung) auf dem
WebServer möglich ist. Auf die entsprechende Webseite User Accounts
gelangen Sie über das Menü Administration > User/Password
Management (hierfür müssen Sie der Benutzergruppe Administrator
angehören).

netX Studio Engineering Tool | Web Builder
DOC160207AN01DE | Revision 1 | Deutsch | 2016-12 | Freigegeben | Öffentlich

© Hilscher 2016



Festlegung der Zugriffsrechte auf Webseiten 38/48

Festlegung der Zugriffsrechte der einzelnen Benutzergruppen durch
Ordnerstruktur

Die Zugriffsrechte der Benutzergruppen auf einzelne Webseiten werden im
netX Studio Engineering Tool durch den Ablageort der Webseiten innerhalb
der Verzeichnisstruktur des Web Builders bestimmt. Seiten, die im Ordner
admin liegen, sind nur für Angehörige der Benutzergruppe Administrator
zugänglich, Seiten im Ordner superv nur für die Gruppe Supervisor und
Seiten im Ordner user nur für die Gruppe User. Seiten, die sich nicht in
einem der genannten Ordner befinden, sind frei zugänglich:

Abbildung 36: Zuordnung der HTML-Seiten zu den Benutzergruppen im Web Builder

Falls Sie eigene Webseiten im Web Builder erstellen, können Sie somit die
Zugriffsrechte auf die Seiten steuern, indem Sie die Seiten in den
entsprechenden Ordnern ablegen.
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Die folgende Tabelle zeigt, welche Zugriffsrechte auf einzelne Webseiten
sich für welche Benutzergruppe nach dem Build-Prozess und dem
Download des Web-Contents in das Zielgerät per Default ergeben (d. h.
falls Sie die oben gezeigte Ablagestruktur nicht ändern):
Benutzergruppe
(Rolle)

Erlaubt Zugriff auf Navigation im Menü des
WebServers

Administrator Startseite mit Version Info, Type
Label (virtuelles Typenschild) und
Maintenance
(Wartungsinformationen)

Home

Benutzerverwaltung Administration > User/Password
Management

Geräte-Neustart Administration > Device Reset
Supervisor Startseite mit Version Info, Type

Label (virtuelles Typenschild) und
Maintenance
(Wartungsinformationen)

Home

IP-Einstellungen Diagnosis > IP Settings

Konfiguration MQTT Client Configuration > MQTT Client
Konfiguration OPC UA Server Configuration > OPC UA Server

User Startseite mit Version Info, Type
Label (virtuelles Typenschild) und
Maintenance
(Wartungsinformationen)

Home

Diagnose Netzwerkstatus Diagnosis > Communication
Diagnose Ethernet-Verbindung Diagnosis > Ethernet
Lesen und Schreiben von
Objektdaten

Diagnosis > Object Data

Herunterladen der
Gerätebeschreibungsdatei

Download

Tabelle 2: Zugriffsrechte der Benutzergruppen (Default)

Wenn Sie keiner Benutzergruppe angehören (Anonymus), können Sie
lediglich die Startseite (Home) des WebServers aufrufen. Sobald Sie
weitere Seiten aufrufen, erscheint ein Login-Dialog. Falls Sie sich als
Nutzer anmelden, der nicht die geforderten Zugriffsrechte besitzt (d. h.
nicht der entsprechenden Benutzergruppe angehört), wird der Zugriff
verweigert.
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7 netPROXY-Objekte in Webseiten einbinden
Übersicht

Der WebServer kann über den netPROXY-Server per JavaScript auf
netPROXY-Objekte (z. B. IO-Daten von Aktoren und Sensoren) lesend und
schreibend zugreifen und diese dynamisch in seine Webseiten einbinden.
Der mitgelieferte Standard-Content des Web Builders ermöglicht nach dem
Download in das Gerät den Aufruf einer solchen Webseite mit Objektdaten
im Navigationsmenü unter Diagnosis > Object Data:

Abbildung 37: Beispiel für Webseite mit netPROXY-Objekten

Voraussetzung

Voraussetzung hierfür ist, dass Sie vorher im netX Studio Engineering
Tool in den Object Definitions die Objekte, die dem WebServer zur
Verfügung stehen sollen, mit einem entsprechenden Label versehen haben
[siehe Position (1) in der folgenden Abbildung] sowie Ihrem Gerät bzw.
Projekt in den Communication Settings das Element Web Server
hinzugefügt und dort die „gelabelten“ Objekte ausgewählt haben [siehe
Position (2) in der übernächsten Abbildung].

Informationen hierzu finden Sie im Bedienerhandbuch netX Studio
Engineering Tool, DOC160103OIXXDE im Abschnitt WebServer,
OPC UA, MQTT ergänzen.
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Abbildung 38: Objekt für den WebServer-Zugriff „labeln“

Abbildung 39: Einem Produkt einen WebServer und „gelabelte“ Objekte hinzufügen
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JavaScript-Funktionen

Die für das Einbinden von netPROXY-Objektelementen in eine Webseite
verwendeten JavaScript-Funktionen
· netPROXY-Objektelement lesen (function readDataValues mit

op=read)

· netPROXY-Objektelement schreiben (function doWrite mit
op=write)

· netPROXY-Objektbeschreibung lesen (function updateTable mit
op=getD)

sind in der JavaScript-Datei neticiot.js definiert, die sich im Ordner
Web Builder > Content > js befindet:

Abbildung 40: Java Script-Datei neticiot.js
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netPROXY-Objektelement lesen

Diese Funktion ist in der function readDataValues (ab Zeile 366) mit
op=read definiert:

Abbildung 41: Code in JavaScript für das Lesen von netPROXY-Objektelementen

netPROXY-Objektelement schreiben

Diese Funktion ist in der function doWrite (ab Zeile 599) mit
op=write definiert:

Abbildung 42: Code in JavaScript für das Schreiben von netPROXY-Objektelementen
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netPROXY-Objektbeschreibung lesen

Diese Funktion ist in der function updateTable (ab Zeile 121) mit
op=getD definiert:

Abbildung 43: Code in JavaScript für das Lesen von netPROXY-Objektbeschreibungen
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